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1. Introduction: 

Here is a picture of what the MT4 main screen looks like 
 

 
Main menu (access to the program menu and settings); 

Toolbars (quick access to the program features and settings); 

"Market Watch" window (real-time quotes for the specified instruments); 

"Navigator" window (quick access to all your accounts, indicators, expert 

advisors); "Chart" window; 

"Terminal" window (quick access to the trading and account history, list of open 
positions and placed orders, client terminal log-file and internal mailbox).      
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2. MT4 DOWNLOAD LINK  
 
To download MetaTrader4 platform from Website 

 
  http://www.aliceblueonline.com/assets/images/uploads/downloads/tradize4setup.exe 

 

 

 
3. MT4 INSTALLATION 

 
 
After downloading the file double click on it and Run the 
MT4Chart setup. 

 
 

a) Launch the MT4Chart exe file the same way you will get.  
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Click on the Next Button 

 
 

b) After Clicking the Next Button You will get the Screen like this 

 

 

 

 
 

Then Click on the Install Button 

 

c) After Clicking the Install Button You will get the Screen like this 
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Then Click on the Finish Button 
 
 

d) After Clicking the Finish Button You will get an ICON on Desktop like this 
 

 
Double Click On it 
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e) You will get an Screen like this 
 

 
 
 
 
After coming this Screen Put your Login No & Password for  LOGIN it….. 
 
 

Then your MT4 terminal will get in to LOGIN… 
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4. ALICE BLUE INDICATOR 

 

INSTALLTION PROCEDURE  

 
a)  To use Alice Blue Indicator  Go to Indicators Folder   At there will be an 

Folder Name- AB INDICATOR. 

 
b) In that there will 3 Indicators named  ABCPITICK / ALICECW / ALICESW 

 
c) Right Click on the Indicator name and click Attach to a Chart on the 3 

indicators one by one.  
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d) After attaching Indicator you will get an Page like this 
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5.ALICE BLUE SCANNER 

 
PRODUCT DESCRIPTION 

 
This is one of the customized indicator tools for Meta Trader Charting Platform. It’s 
showing the Super Trend Indicator trending levels with stop loss, 3 Takeprofit levels 
value of the available scripts in market watch window in MT4 chart. 

While clicking the Symbol Name Button it will open the respective script chart window 
with Super Trend Indicator at current Time Frame. 

 

In this main screen, showing symbol name with Stop Loss value, Entry Price, Last 
Traded Price and 3 Level Take Profit. 

 

INSTALLTION PROCEDURE  
 

a) To use Alice Blue Scanner  Go to Indicators Folder   At there will be an 
Folder Name- AB SCANNER. 

 
b) In that there will 2 Indicators named  ALICE_SCANNER / 

ALICESCANNER_ST  

 
c) Go to Tools menu  In that Option Click Expert Advisor and Enable Allow 

Automated trading &  Allow DLL Imports and Click OK Button 
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d) In that Right Click on the Indicator name ALICE_SCANNER and click Attach to a 
Chart 

 

.  
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e) After attaching to chart you change parameter from Input according to your 
strategy  and then Click OK 

 

 
 

f) After clicking Ok you will get an Screen like this 
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g)  While clicking the Symbol Name Button it will open the respective script chart window with 

Super Trend Indicator at current Time Frame.  
 

 
 

 

h) You can Set Mobile Notification for each signal.  Whenever the Entry comes you 
will get an message to your mobile.  To do this Go to Options From Tools Menu 

 

     

Step 1: Find your “MetaQuotes ID” 

The MetaQuotes ID is a unique code assigned to your device. On your mobile device, download and 

open MetaTrader 4 mobile. Go to the settings menu. Scroll down to the “Messages” header. You will 
see “MetaQuotes ID” and an 8-character code. 
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               Step 2 : Put that “MetaQuotes ID” in BOX  

 

Step 3: Test your connection 
After  you enter your MetaQuotes ID, click “Test.” This will generate a test message to your mobile 

device. It will prompt you to check your journal. You can look in the “Journal” tab of the terminal 

window to confirm the notification was sent. If set up properly, you will receive a notification in your 

status bar and in the “Messages” area of MT4 Mobile. 
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6. ALICE BLUE ONE CLICK TRADE 

 
PRODUCT DESCRIPTION 
 

 This is one of the customized indicator tools for Meta Trader Charting Platform. Place Instant order in One 

click to NEST terminal. 

WHY USE ONE CLICK TRADING? 
 

One Click trading has a lot of benefits that help you to take advantage in trading. While clicking the Buy 

or Sell Button it will place the order in Client Nest Terminal Instantly.  

•Save Your Time 

•Instant & Quick Execution 

•Easy to Place order in High Volatile Market. 

•Buy SL/Sell SL Order Execution with Multiple lot 

•Easy to close all Trades in One click 

•Easy for Newbie’s Traders 

 

 

 

INSTALLTION PROCEDURE : 

 
a) To use Alice Blue One Click Trade  Go to Indicators Folder  There will be 

an Folder Name- AB ONE CLICK TRADE. 

 
b) In that there will 2 Indicators named  Alice One Click Trade- 32 Bit / Alice 

One Click Trade- 64  
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c) Go to Tools menu  In that Option Click Expert Advisor and Enable Allow 
Automated trading &  Allow DLL Imports and Click OK Button 

 
 

d) Check your system is made up of 32 or 64 Bit. If your System is 32 Bit then 
Right Click on Alice One Click Trade- 32 Bit  and click Attach to a Chart 
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e) After attaching to chart you will get an Input window like this.  

 
 

 
 
 

f) In MyLoginID Type your Nest ID & In MyTransPwd Type your Nest 
Transaction Password. ( If you Don’t have Transcation Password then 
type as- ALICE000)  
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g) After giving Input Details click OK Button. Then you will get an Window like 
this 

 

 
 

 

        

 g) For Instant Buy or Sell entry you can directly click the BUY or SELL button. By    
Clicking the Button it will place order in your NEST acc.  
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7. ALICE BLUE AP TOOL 

 
PRODUCT DESCRIPTION 
 

 This is one of the customized indicator tools for Meta Trader Charting Platform. Place Instant order for 

Multiple Clients in One click to NEST terminal. 

WHY USE AP ONE CLICK TRADING? 
 

AP One Click trading has a lot of benefits that help you to take advantage in trading. While clicking the 

Buy or Sell Button it will place orders to MULTIPLE Clients Instantly .  

•Save Your Time 

•Instant & Quick Execution to all clients 

•Easy to Place order in High Volatile Market. 

•Buy SL/Sell SL Order Execution with Multiple lot 

•Easy to close all Trades in One click 

•Easy for Newbie’s Traders 

 

 

 

INSTALLTION PROCEDURE : 

 
a) To use Alice Blue One Click Trade  Go to Indicators Folder  There will be 
an Folder Name- AB AP TOOL. 

 
b) In that there will 2 Indicators named  Alice AP One Click Trade- 32 Bit_AP 

/ Alice AP One Click Trade- 64 Bit_AP 

 
c) Go to Tools menu  In that Option Click Expert Advisor and Enable Allow 
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Automated trading &  Allow DLL Imports and Click OK Button 

 
 

d) Check your system is made up of 32 or 64 Bit. If your System is 32 Bit then 
Right Click on Alice AP One Click Trade- 32 Bit_AP  and click Attach to a 
Chart 
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e) After attaching to chart you will get an Input window like this.  

 

 
 
 

f) In MyLoginID Type your Nest ID  
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g) After giving Input Details click OK Button. Then you will get an Window like 
this 

 

 
 

 

 

 

 

h) By this tool we can Place order for NRML & MIS mode also. And We can 
Place for Current & Nest Month Contract also 
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i) By  this tool we can Place order to Multiple Clients by Saving their Nest Login 
Id in MyClients Notepad.  

For doing this you need to Click MyClients Button. After Clicking you will get 
an Notepad File. In that Add your Clients Nest Id details.  

 
 

j) After finishing it Save the file and close the notepad. By doing this you can 
place instant order to all clients in Same pair.  

Like this you can save Multiple Pairs list for Multiple Clients. 
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 k) For Instant Buy or Sell entry you can directly click the BUY or SELL button. By    
Clicking the Button it will place order in your NEST acc.  

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

mailto:robotz.in@gmail.com


      
 
 

www.robotz.in                           robotz.in@gmail.com 
 
 
 
                                                                           
 

 

 

IMPORTANT IF ONE CLICK NOT WORKED: 

 
1. Right Click on the MT4Chart Icon and Click Troubleshoot Compatibility.  

 

 

 

2. Click on Try Recommended Settings 
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3. After Clicking it. Click the Start The Program Button And Click NEXT Button 

 
 

4.After Clicking Next, Click the Yes, Save these setting for this Program. 
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.  

 

5. After Finishing Close the Troubleshooter 

 

 

6. Program Will Restart and file get open 
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8. GENERAL INSTRUCTIONS FOR NEST & MT4 
 

 
a) Configuration of Trading Terminal NEST: 

 
➢ Check Order Settings in Nest 

➢ Select -  Single Click to Execute Order  in  Nest  order system 
 
 

b) Check Order Settings in Nest: 

 
Location for NEST: Nest - Preferences- Order Settings 

 
Keep these options - Disabled in terminal Order settings 

 
➢ Fresh Order 

➢ Order Modification 

➢ Market Order 

➢ Order Cancellation 

 
c) Configuration of  MT4 Trading Terminal  
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    Go to Tools menu  In that Option Click Expert Advisor and Enable Allow 
Automated trading &  Allow DLL Imports and Click OK Button 

 
 
 

The Market Watch Window: 
 
The "Market Watch" window can be activated by pressing the Ctrl+M key combination, or by using  

the View->Market Watch menu sequence or by clicking the  button from the "Standard" toolbar: 

 
Right click the mouse button on the "Market Watch" window to produce the context menu: 

 
New Order – enables the window to open/close a 
position or to place a new pending order; 

Chart Window – enables the chart of a currency pair 
or CFD; 

Tick Chart – shows the tick chart for the selected 
instrument; 
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Hide – deletes the specified symbol from the list in the 
"Market Watch" window; 

Hide All – deletes all symbols from the list in the 
"Market Watch" window which are not used (if you 
have open positions or charts, its symbols will not be 
deleted); 

Show All – displays all available symbols in the 
"Market Watch" window; 

Symbols – enables the window where you can 
hide/show the selected instruments; 

Sets – saves/adjusts/deletes the custom settings for 
the "Market Watch" window; 

High/Low – shows/hides columns with the highest 
and lowest prices for each instrument; 

Time – displays a column with the arrival time of the 
latest quote for each instrument; 

Grid - hides/unhides gridlines in the "Market Watch" 
window; 

Popup Prices – opens the popup window which 
contains real time quotes for your selected 
instruments. 
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In MetaTrader 4, you can see as many real time charts as you wish, all on one screen, for any 
currency pair and for any time period. The following types of charts are available in MetaTrader 4: 

Line Chart. Chart x-axis is for the different time periods (minutes, hours, days, months etc.), 
and y-axis is for the price. The point on the chart shows the close price for the period, i.e. the 
bid of the last quote for this period. All the sequential points are joined by lines: 

 

It is recommended that this chart type is used only for the short time periods (up to 5 minutes). 

In order to change the chart to a line chart, press the  button on the «Charts» toolbar: 
 

 
or press the Alt+3 key combination or use the Charts -> Line Chart menu sequence. 

 
Bar Chart. The chart is created with the use of bars. Each bar has a high (top), a low (bottom), 
an opening price (left horizontal little line) and a closing price (right horizontal little line) for the 
specified period of time (for example, an hour): 
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It is recommended that you use this chart type for periods of 5 minutes or more. In order     

to change the chart to a bar chart press the  button on the "Charts" toolbar 
 

 
or press the Alt+1 key combination, or use the Charts -> Bar Chart menu sequence. 

 
Candlesticks. These charts are created in the same way as bar charts: 

 

 

Candlesticks charts were very popular in the 80-90s because of their clear graphics. 
This method of technical analysis is based on the correlation between both closing 
and opening prices within the same trading day, and the closing price of the previous 
session and the opening price of the next session. 

 
Candlesticks have different configurations compared to bar charts. The rectangular part of 
the candlestick line is called the real body. The thin vertical lines above and below the 
body are called shadows. They show lows and highs within a specified period of time. 
Depending on the closing and opening prices the real body can be white (empty) or 
black. When the body is white, the closing price is higher than the opening level. When 
the body is black, the closing price is lower than the opening level. 

 

In order to create a candle chart press the  button on the "Charts" toolbar: 
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the Alt+2 keys simultaneously, or use the Charts -> or press Candlesticks menu sequence 
 
 

In order to create a new chart for any instrument right click on the "Market Watch" window,        then 
select the Chart window item from the context menu: 

 

 
By left clicking the mouse you can drag and  drop any  selected currency  pair  into  any  open  
chart window. 

 
 

Chart period – the period displayed in one bar or candle. For example, if you create a 15 minute 
bar chart, then each bar will have the price data for the relevant 15 minutes. In MetaTrader 4 the 
following time periods can be used: 1, 5, 15, 30 minutes (M1, M5, M15, M30 respectively), 1 hour 
(H1), 4 hours (H4), 1 day (D1),  1 week  (W1) and 1 month (MN).  In order  to change a time  
period,  use  the "Periodicity" toolbar: 
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Right click anywhere on the chart to produce the context menu to get access to the chart settings: 
 
 
 

 

 

Choose Periodicity and select a time period from the drop down menu or press the  
button on the "Charts" toolbar; 

 

Select Refresh item if an error occurs or if there are so called "gaps" on the chart. All missing 
data will be uploaded from the server and will appear on the chart; 

 

Select Grid if you wish to hide/unhide gridlines on the chart; 
 

Select Volumes in order to show/hide tick volume (the number of quotes of any period time); 
 

Zoom in / Zoom out will help you to modify chart measures. You can also use the /   
buttons on the "Charts" toolbar or press the "+" and "-" buttons; 

 

Save as picture… will save the chart as the *.gif, or *.bmp. file; 
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Properties… (or the F8 button) enables the window where you can change chart settings, by 
selecting the "Color" tab you can change the color of any element on the chart: 

 

 
Other settings can be changed in the Common tab: 
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Please note the following options: 

Offline chart - the chart is not being updated by new quotes. Once you open 
the chart offline (File -> Open offline) this option becomes automatic; 

Chart shift – allows you to shift the chart from the right edge of the window, 

to see the most recent candle forming. You can also press the  button on 

the "Charts" toolbar or use the Charts -> Chart shift menu sequence; 

Chart autoscroll - autoscrolls to the left once a new quote is received. You can 

also press the button on the "Charts" toolbar or use the Charts -> 
Autoscroll menu sequence. If you are viewing the chart back a few days, and 
the autoscroll button is depressed, it will automatically take you to the most 
recent candle forming on the next tic of the price. 

 

How to install Indicators,Experts,Scripts,Templates in MT4 

 Step By Step instructions  

How to install software (Indicators, Experts, Scripts,  

Templates) into new MT4  
 

 1.  Open your MetaTrader 4 

 2.  Click File — Open Data Folder (Picture #1) 
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 Pic.1  File — Open Data Folder 

  

Here you will find a folder called MQL4: 

 

 Pic.2  MQL4 Folder 
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3.  Open MQL4 folder.  Now, you’ll see these folders: 

  

 

 Pic.3  Folders into MQL 

\Experts – Expert Advisors (trading robots), 

\Indicators – custom indicators, 

\Scripts – scripts (MQL4 applications for a single run on the chart), 

\include – source code MQH and MQ4 files implemented into other programs, 

\libraries – libraries in the form of MQ4 source codes and EX4 executable files compiled from them. They are used 

for the dynamic call of the functions contained there by other MQL4 programs, 

\Images – image files for using in resources, 

\files – special “file sandbox”. MQL4 applications are allowed to execute file operations only within this directory. 

 

4.  Insert your files : 

– Insert your EA files (ex4 or .mq4) into MQL4/Experts folder. 

– Insert your Indicators  (ex4 or .mq4) files into MQL4/Indicators folder. 

– Insert your Scripts files (ex4 or .mq4) into MQL4/Scripts folder. 
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– Insert Settings files of EA (.set) into MQL4/Presets folder. 

– Insert your Libraries files (dll) files into MQL4/Libraries folder. 

– NOTE: Template files must be  NOT in “MQL4 folder” . Copy your  .tpl files into templates folder 

(Picture #4). You can find templates  folder when open your Data Folder) 

 

  Pic.4  Templates  Folder 

 

5. Restart your MetaTrader 4 after Attaching.  

 
 

 
Thank you 
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